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Preface 

 

Regulatory Disclaimer 
For Research Use Only. Not for use in diagnostic procedures. 

Terms and Conditions of Use 
You are prompted to agree to the terms and conditions of use the first time you log into the NimbleDesign Software 
and if the terms of use are subsequently changed. 

Roche does not guarantee the results achieved from experiments performed using custom enrichment designs. 

Recommended System Requirements 
To use the NimbleDesign Software, your computer must have a web browser from the list below installed and JAVA 
enabled. The recommended browser is Google Chrome (v50); however, other current versions of Internet Explorer, 
Mozilla Firefox, Google Chrome, or Apple Safari are expected to function in the same manner. 

 

Contact Information 

Technical Support 

If you have questions, contact your local Roche Technical Support. Go to sequencing.roche.com/support.html for 
contact information. 

 

Conventions Used in This Manual 
Symbols 

Symbol Description 

 
Information Note: Designates a note that provides additional information 
concerning the current topic or procedure. 

 

Text 

Conventions Description 

Numbered listing Indicates steps in a procedure that must be performed in the order listed. 

Italic type, blue Identifies a resource in a different area of this manual or on a web site. 

Italic type Identifies the names of dialog boxes, windows, tabs, panels, views, or message boxes in the software. 

Bold type Identifies names of menus and controls (buttons, checkboxes, etc.) in the software. 
 

http://sequencing.roche.com/support.html
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Chapter 1. Before You Begin 

This User’s Guide describes the process for how to use the NimbleDesign Software to create custom enrichment 
designs. The NimbleDesign Software is free to all Roche customers and can be accessed at 
sequencing.roche.com/products/software/nimbledesign-software.html. 

What is NimbleDesign Software? 
The NimbleDesign Software is a secure, browser-based tool that allows you to create custom SeqCap EZ, SeqCap 
Epi, SeqCap RNA, HEAT-Seq, or HEAT-Seq Ultra enrichment designs to meet your specific research needs using 
the Roche preselected probe database. 

Using the NimbleDesign Software, you can: 

• Create SeqCap EZ, SeqCap Epi, SeqCap RNA, HEAT-Seq, or HEAT-Seq Ultra enrichment designs. 

• Create designs by: 
o Uploading genomic coordinate files or a text file of commonly used gene identifiers, and/or 
o Manually entering probe coordinates or gene identifiers. 

• View probe selections against genomic regions of interest via SignalMap. 

• Verify and approve designs before they are submitted to manufacturing. 

• Place an order for custom SeqCap EZ, SeqCap Epi, SeqCap RNA, HEAT-Seq, or HEAT-Seq Ultra kits 
online in countries where online ordering is supported (see Chapter 2) or through your sales affiliate where 
online ordering is not supported (see Chapter 4). 

• Retrieve final design files needed for sequencing analysis for your probe designs once order process is 
complete. 

 

 
To verify you are using the most up-to-date version of this User’s Guide, go to 
sequencing.roche.com/products/software/nimbledesign-software.html. 

 

What’s New? 
 HEAT-Seq Choice designs has an increased quantity of maximum probe numbers.  

  

http://sequencing.roche.com/products/software/nimbledesign-software.html
http://sequencing.roche.com/products/software/nimbledesign-software.html
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The Workflow 
Here is a summary of the workflow to create (Chapter 3), order (Chapter 4) a custom enrichment design and retrieve 
design files (Chapter 5) using NimbleDesign Software. 

• Specify Design Details [Design tab] 

• Define Region(s) of Interest [Target Regions tab] 

• Set Parameters [Parameters tab] 

• Submit for Design Probe Selection [Review tab] 

• Review the Design [Review tab, SignalMap] 

• Approve the Design [Review tab] 

• Order an Enrichment Design [Your Shopping Cart tab] 

• Retrieve Design files [Review tab] 

Background Information 

Prepare to Create a Custom Design 

The success of an experiment depends on the initial design, which involves choosing the desired genomic build, 
picking the correct application (SeqCap EZ, SeqCap Epi, SeqCap RNA, HEAT-Seq, or HEAT-Seq Ultra Target 
Enrichment Systems) and selecting an appropriate set of probes. Before launching the NimbleDesign Software, you 
should identify the genomic region(s) of interest you would like to cover in your design (including control regions), 
preferred close matches (used during initial probe selection), and maximum close matches (used to generate 
adequate coverage in the final design). Additionally, for HEAT-Seq and HEAT-Seq Ultra Target Enrichment 
Systems you can opt to select probes to target both strands (both top and bottom) or only one strand (either top or 
bottom). 

Genomic Build 

The following genomes and builds are supported by NimbleDesign Software:  

• Homo sapiens 
o hg19 /GRCh37 – Ensembl version 75 
o hg38/GRCh38 – Ensembl version 80 

• Mus musculus (SeqCap EZ, SeqCap Epi, and SeqCap RNA designs, only) 
o mm9/MGSCv37 – Ensembl version 67 
o mm10/GRCm38 – Ensembl version 75 

• Rattus norvegicus (SeqCap EZ, SeqCap Epi, and SeqCap RNA designs, only) 
o rn6/RGSC 6.0 – Assembly date July 2014 
o rn5/RGSC 5.0 – Assembly date March 2012 

• Bos Taurus (SeqCap EZ, and SeqCap RNA designs, only) 
o Bos_taurus_UMD_3.1.1/bosTau8 – Assembly date June 2014 
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Available Formats 

SeqCap EZ, SeqCap Epi, SeqCap RNA, and HEAT-Seq Ultra Target Enrichment Systems are offered in different 
formats. The NimbleDesign Software will automatically choose the correct format based on the size of your 
requested target regions after padding. Format options are: 

• SeqCap EZ Choice for genomic DNA designs smaller than 7 Mb (Human). 

• SeqCap EZ Choice XL for genomic DNA designs 7 Mb to 200 Mb (Human). 

• SeqCap EZ Developer for genomic DNA designs targeting regions up to 200 Mb (Human, Mouse, Rat and 
Cattle). 

• SeqCap Epi Choice (S, M, L) for bisulfite-converted genomic DNA designs up to 90 Mb (Human). 

• SeqCap Epi Developer (S, M, L, XL) for bisulfite-converted genomic DNA designs up to 210 Mb (Human, 
Mouse, Rat and Cattle). 

• SeqCap RNA Choice for RNA targeting designs smaller than 7 Mb (Human). 

• SeqCap RNA Choice XL for RNA targeting designs from 7 Mb to 100 Mb (Human). 

• SeqCap RNA Developer for designs to capture RNA from mouse up to 100 Mb (Human, Mouse, Rat and 
Cattle). 

• HEAT-Seq Choice for designs from 140 to 27,343 target probes (Human). 

• HEAT-Seq Choice Ultra (S, M, L, XL, XXL) from 32 to 6000 target probes(Human). 

Design Probes and Roche Probe Databases 

A SeqCap probe is a DNA oligonucleotide designed to hybridize to complementary DNA sequences in solution, and 
used to selectively enrich these sequences from a sample. The captured DNA fragments can then be sequenced using 
next generation sequencing. 

Roche has created probe databases that meet certain criteria such as synthesis cycles, melting temperatures (i.e. Tm), 
non-repetitive elements, and close matches within the overall genome. This ensures that these probes will perform 
optimally in your designs. 

Roche has created a probe database of HEAT-Seq probes containing both in silico selection criteria and data 
generated from empirical testing. Both the in silico data and the actual performance data of the probes are utilized to 
select a set of probes that will optimally cover each target region of interest. 

Region(s) of Interest 

Prior to launching the NimbleDesign Software, you must determine your region(s) of interest. Region(s) of interest 
are regions of the genome that you would like to cover in your design and may include control regions. Once you 
have identified your region(s) of interest, you will need to generate a list that includes the chromosome coordinates 
(chr, start and stop) for these regions. The UCSC genome browser (genome.ucsc.edu/) can be used to generate lists of 
genomic coordinates for specific regions. 

Alternatively, a list of Gene Identifiers can be used as input to the NimbleDesign Software. 

File Formats for Regions of Interest 

See Appendix A for a description of file formats that may be used to specify regions of interest. 

http://genome.ucsc.edu/
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Software Warnings and Errors 
The steps performed during the creation of a custom design have been validated by Roche. The result of this 
validation is that you may see warning or error messages during the process. 
 

 
Warnings mean that you have encountered a potential problem, but the issue identified 
is not severe enough to prevent you from proceeding with the workflow. 

 
Errors mean that you have encountered an issue severe enough to prevent you from 
proceeding with the workflow. Error messages will require modifications to the design 
in order for you to proceed. 

Errors may also cause some buttons to be disabled (i.e. grayed out). Tooltips will 
indicate why the button is disabled. 

 

Other Custom Designs 
If the current version of the NimbleDesign Software does not support the SeqCap enrichment design you wish to 
create, please contact your local sales affiliate for assistance with placing your order. Go to 
sequencing.roche.com/support.html for contact information. However, HEAT-Seq and HEAT-Seq Ultra Choice 
designs are limited to selected targets in the human genome and can only be created in NimbleDesign. 

http://sequencing.roche.com/support.html
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Chapter 2. Getting Started 

This chapter describes the registration process on the NimbleDesign Software and provides guidelines on the 
enrichment design process. 

Register 
To access NimbleDesign Software, you must register. Registration ensures that the correct contact information 
needed for the design process is obtained. During registration, you create a user ID and password to access the 
website. If you already have an account with Roche, the same user ID and password will allow you access to the 
NimbleDesign Software. 

1. Go to sequencing.roche.com/products/software/nimbledesign-software.html. 

2. Choose Login for NimbleDesign, and then choose Continue. 

3. If this is your first time to visit the website on your computer, select your country from the dropdown box, and 
choose Select Country. 

 

http://sequencing.roche.com/products/software/nimbledesign-software.html
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4. Choose Register to begin the registration process. 

 

5. Follow the steps to create your account. If your country supports online ordering, you will be directed to the 
registration website. If your country does not support online ordering, you will be required to enter your user 
ID, password and contact information. 

 

 
The Logon ID (User ID) must consist of alphanumeric characters and cannot 
contain any special characters (e.g. %, &, -, or #). 

 
The password must contain at least six characters and employ both alpha and 
numeric characters. The password cannot be the same as the User ID or contain 
repeated characters. 
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Log In to NimbleDesign Software 
1. Go to sequencing.roche.com/products/software/nimbledesign-software.html. 

2. Choose Login to NimbleDesign, and then choose Continue. 

3. Enter your User ID and password and choose the Login button. 

 
 

 
If you have forgotten your password, choose the Forgot your Password? link and 
follow directions in the email that will be sent to you. 

 
Log in after you complete registration to activate your NimbleDesign user ID. This 
will enable your design order (Chapter 4) and design files delivery (Chapter 5) link 
with the user ID.  

 
 

Log Out of NimbleDesign Software 
At the top of every NimbleDesign Software page, the Logout link is visible (below). You can choose this link at any 
time and logout of the software. The software will save any completed workflow steps so that when you return to the 
program, your input will be saved. 
 

 
 

 
The NimbleDesign Software will automatically log you out if there has been no activity 
on your account for longer than 15 minutes. The software will save any completed 
workflow steps so that when you return to the program, your input will be saved. 

To re-access the NimbleDesign Software follow the instructions for logging in to the 
software. 

 

http://sequencing.roche.com/products/software/nimbledesign-software.html
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Navigate NimbleDesign Software 
The NimbleDesign Homepage is shown below. More details about each button, link or section are described next to 
the corresponding letter below. 

A. Home – This link will take you to the NimbleDesign Homepage (screenshot below). 

 
B. Designs – This link will take you to the Designs page, which lists all of the designs you have previously 

created, as well as several standard catalog designs. Additional information about each design can be 
obtained by choosing the design identifier listed in the far left column of the My Designs or Catalog Designs 
tab. 

 
  



Chapter 2. Getting Started 

NimbleDesign Software User’s Guide, v4.3 14 

C. History – This link will take you to the Submission History page and contains information on designs that 
you have submitted for ordering. 

 
 

D. Profile ( ) – This link will take you to the login page where you can edit your profile information. 

E. Cart ( ) – This link will take you to the Your Shopping Cart page. This page lists all designs that you have 
placed in your shopping cart but have not ordered. 

 
 

F. Help ( ) – This link will take you to the most recent version of this User’s Guide, opened in a PDF 
viewer. You can navigate via the links in the table of contents or navigation pane, and can print either 
individual pages or the entire manual. 

G. NimbleDesign Document Center – This section of the NimbleDesign Homepage will list customer-facing 
documents specific to NimbleDesign Software. Examples include User’s Guide, NimbleDesign Brochures, 
Training videos, etc. 
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H. Messages – This section of the NimbleDesign Homepage will list any messages from the software. These 
messages will provide information on completed probe selections, ordered designs or errors. You can delete 
messages by choosing the  icon next to the message. You can clear all messages by choosing the Clear All 
Messages button next to the Messages heading. 

 
 

I. Recent Designs – This section of the NimbleDesign Homepage lists your five most recent designs and 
allows you to choose any design name for more information. 

J. Contact NimbleDesign Technical Support – The link Contact Roche Sequencing Technical Support located 
on the NimbleDesign Homepage allows you to contact Roche for additional assistance. 

 

Help Provided in NimbleDesign Software 
The NimbleDesign Software provides the following ways to learn about the software and how to use it to design and 
order custom enrichment designs: 

• Help icon ( ) – When located in the upper right corner of the software, this link will take you to the 
most recent version of this User’s Guide (as described above). 

• Information icon ( ) – When located adjacent to a field, positioning the mouse cursor over this icon 
will display a tooltip with additional details about the field and how to populate it. 
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Chapter 3. Create a Custom Enrichment Design 

Follow the steps below to create a custom enrichment design for SeqCap EZ, SeqCap Epi, SeqCap RNA, HEAT-Seq, 
or HEAT-Seq Ultra Target Enrichment Systems. 

Step 1. Specify Design Details 
Basic information regarding the new design is entered in the Design tab. 

1. Choose one of the following options to specify design details: 

• Choose the Create New Design button on the NimbleDesign Homepage or Designs page. 

• Choose the Previous button on the Target Regions tab. 

• Select the Design tab. 

 
 

2. Input Basic Info in the Design tab. 
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a. Customer Design Identifier – Enter a name for your new design project, which will be incorporated into 
the Final Design Identifier. The Customer Design Identifier can be no more than 14 characters, and can 
contain only letters, numbers, hyphens (-), and underscores (_). 

 

 
The Customer Design Identifier is used as part of the file name for the 
reports generated for your design (see the Guide for Reviewing and Approving 
for your selected product.) 

 
The Final Design Identifier is a unique name that will appear on the label of 
the vial containing your targeting DNA oligos. 

 

b. Organism - Homo sapiens, Mus musculus, Rattus norvegicus, and Bos Taurus are the only organisms 
currently available for the SeqCap EZ and SeqCap RNA through NimbleDesign Software. Homo sapiens, 
Mus musculus, and Rattus norvegicus are available for SeqCap Epi designs through NimbleDesign. 
HEAT-Seq and HEAT-Seq Ultra Target Enrichment Systems only allow designs for Homo sapiens. 

c. Genomic Build – Once organism is selected, the available genomic builds will be available for selection. 
Supported builds are listed in Chapter 1. 

d. Application – Choose between SeqCap EZ, SeqCap Epi, SeqCap RNA, HEAT-Seq, and HEAT-Seq Ultra 
Target Enrichment Systems. 

e. Description (optional) – Enter additional information about your design. Since the Customer Design 
Identifier field is limited in length, you may choose to describe your design in more detail in this field. This 
will be helpful if you need to distinguish multiple designs. 

 

 
The Description field can be no more than 255 characters and can contain 
only letters, numbers, spaces, hyphens (-), and underscores (_). 

 
Once the Design tab has been completed by choosing the Next button, you can 
navigate the tabs in any order. The Summary button on the upper right corner 
can be selected at any time to review design details. 
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Step 2. Define Region(s) of Interest 
 

 
Note that region information may be automatically modified, padded, or consolidated 
by the NimbleDesign Software (see Appendix B). 

 

A region of interest to which probes must be designed is specified in the Target Regions tab. 

1. Proceed to the Target Regions tab using one of the following options: 

• Choose the Next button on the Design tab. 

• Choose the Previous button on the Parameters tab. 
2. Select the Target Regions tab. 

 
3. Select one of three different ways to define the genomic regions of interest: 

• Manual Entry 

• Upload File 

• Gene Search (limited to for Homo sapiens and Mus musculus designs) 
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Manual Entry 

a. Choose the format to be used for Select Input Type. 

 
 

 
Note that for HEAT-Seq and HEAT-Seq Ultra applications, Select Input Type will 
default to HGNC symbol(s). 
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For Rattus norvegicus and Bos Taurus designs, Genomic Coordinates is the only 
available Input Type. 

 
 

b. Enter regions of interest into the input box. The format must be one of the following options and match the 
type you just chose. 

• Genomic Coordinates 
o chrN:start-stop<return> 
o chrN<tab>start<tab>stop <return> 
o chrN<tab>start<tab>stop<tab>name<return> 

• Gene Identifier 
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c. Tags can be added to each set of regions added to a design. Add or remove tags, as desired. The Tags can be 
no more than 14 characters, and can contain only letters, numbers, hyphens (-), and underscores (_). 

 
 

d. If only protein coding regions are desired, check the box for Add Coding Sequence regions only. 

e. If only protein coding transcript Biotype regions are desired, check the box for Add Protein Coding 
Transcript BioType regions only.  

 
Note that for HEAT-Seq and HEAT-Seq Ultra applications, Add Coding Sequence 
regions only and Add Protein Coding Transcript Biotype regions only will be 
checked by default for all Select Input Type options except the Genomic 
Coordinates entry. 
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f. Choose Add Features to List and review any errors that may have occurred. 

 

 
 

 

 
General descriptions of the biotypes listed in the Transcript BioType column 
can be found here: 
vega.sanger.ac.uk/info/about/gene_and_transcript_types.html 

Specific definitions of the biotypes used by ENSEMBL’s annotation pipeline 
(Havana and VEGA) can be found on Vega’s page: 
vega.sanger.ac.uk/info/about/gene_and_transcript_types.html 

 

g. Continue entering additional regions, as desired. 

h. Once all regions have been added, proceed to Step 3: Set Parameters. 
 

http://rm2us0282.mah.roche.com:8080/vega.sanger.ac.uk/info/about/gene_and_transcript_types.html
http://vega.sanger.ac.uk/info/about/gene_and_transcript_types.html
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Upload File 

 
a. Choose the format to be used for Select Input Type (see Appendix A for a description of allowed file types). 

 
For Rattus norvegicus and Bos Taurus designs, Genomic Coordinates is the only 
available Input Type. 

b. Choose the Browse button to navigate to your file and choose Open. 

o Alternatively, drag and drop the file to the input window. 
o If the file format (.txt) is incorrect an error will be reported back in the input window. 

c. Add or remove tags for each uploaded region, as desired. 

d. Continue uploading additional files, as desired. 

e. Once all regions have been added, proceed to Step 3: Set Parameters. 
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Gene Search 

 
a. If only protein coding regions are desired, check the box for Add Coding Sequence regions only. 

o Currently NimbleDesign Software uses all regions of the annotated transcripts including untranslated 
regions (UTR) to produce probe designs for any given gene identifier. Inclusion of UTR results in 
unnecessary expansion of the intended primary target for the many customers that may be interested 
in only identifying the coding regions. With the ability to focus on just the coding regions, customers 
will be able to get focused designs created for their intended target. 

b. If only protein coding transcript Biotype regions are desired, check the box for Add Protein Coding 
Transcript BioType regions only. 

c. Type a gene name into the cell. As you begin typing the available gene identifiers will auto-populate. Select 
the appropriate one for your design by hitting the Return key or with a mouse cursor selection. 

o If the Gene name cannot be found you will see a warning and a suggestion to ‘Try a different spelling’. 
d. Add or remove tags for each uploaded region, as desired. 

e. Choose Add. 

f. Continue adding additional Gene Names as needed. 
 

 
If modifications are required, choose the Previous button or click on  
the tab of interest. 
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Step 3. Set Parameters 
 

 
See Appendix C for details on close match parameters and the Strand Choice. 

 

NimbleDesign Software allows the user to control the stringency of probe design as desired through the Parameters 
tab. It also allows for the choice of targeting either top or bottom strand or both strands in HEAT-Seq and HEAT-
Seq Ultra designs. 

1. Proceed to the Parameters tab using one of the following options: 

• Choose the Next button on the Target Regions tab. 

• Choose the Previous button on the Review tab. 

• Select the Parameters tab. 

 
2. For SeqCap EZ and SeqCap RNA applications, if creating a HG19 Design, pick a reference genome option. 
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3. Enter close match parameters. 

a. Enter a value for Preferred Close Matches (used for initial probe selection). Note that the default and/ or 
suggested parameters across applications may be different. The preferred close match for the SeqCap Epi 
application is required to be 1 and is not modifiable.  

 

b. Enter a value for Maximum Close Matches (used to improve coverage, if necessary). Note that the default 
and/ or suggested parameters across applications may be different. The default maximum close match value 
for the SeqCap Epi application is 3, while the maximum close match = 1 value is suggested. 

 

 
If modifications are required, choose the Previous button or click on the tab of 
interest. 

 

4. Enter strand choice (HEAT-Seq and HEAT-Seq Ultra designs, only). 

a. Choose between: 

o Either Top or Bottom - Choose this option if you would like sequence information from only a single 
strand. Optimal probes will be selected as necessary from either the top strand or the bottom strand to 
provide coverage. For any given region, probes may be exclusively top or bottom strand, or may 
alternate between the two strands. This is the default selection and is appropriate for most experiments. 

o Both Top and Bottom - Choose this option if you would like sequence information from both strands 
in your experiment. Having sequence information from both strands can assist in assessing DNA 
damage and provide higher confidence in SNP calling. Twice as many probes will be selected, and 
twice as much sequence will be necessary to cover the target regions. 
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Step 4. Submit for Design Probe Selection 
The probe selection can be submitted after user review of design using the Review tab. 

1. Proceed to the Review tab using one of the following options: 

• Choose the Next button on the Parameters tab. 

• Select the Review tab. 

 
 

2. Review information and reports in the following sections: 

• Design section – a summary of design details. 

• Regions section – uploaded design regions and region consolidations (see Guide for Reviewing and 
Approving for your selected product. 

• Parameters section– close match parameters. 
 

 
If modifications are required, choose the Previous button or click on the tab of 
interest. 

 
If you decide that you no longer need a design that you generated using the 
NimbleDesign Software, simply remove it by choosing Delete Design. 
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3. Choose the Submit for Selection button. 

• A window will pop up providing you with information about the Design Selection process. 

 
 

• During Design Selection, the NimbleDesign Software uses a proprietary algorithm to actively select the 
probes from the pre-calculated databases to closely match the parameters you chose. Once the probe 
selection is completed, you will receive an email from the system indicating that your design is ready for 
review. The Messages area on the NimbleDesign Homepage will link to the designs that are ready for review. 

 

Step 5. Review the Design  
 

 
Once a design has been submitted for probe selection, the process cannot be canceled. 

Choose Clone Design to make an identical copy that can be modified and submitted as 
a new design. 

 

After probe selection has completed, review the design reports and design probe placement. Notification indicating 
that your design is ready for review will be provided in two forms: 

• Email from DO_NOT_REPLY.nimbledesign@roche.com with the subject line: 
NimbleDesign Notification – Your Design is Ready for Review. 

• Message ‘Design“xxxxx” has a completed probe selection. The job is ready for you to review’ will appear on 
the NimbleDesign Homepage. 

1. Proceed to the Review tab using one of the following options: 

• Choose the link to the design in the Recent Designs area on the NimbleDesign Homepage. 

• Choose the link to the design in the Messages area on the NimbleDesign Homepage. 
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2. Review information and reports in the following sections: 

• Design section – a summary of design details. 

• Regions section – uploaded design regions and region consolidations. 

• Parameters section – close match parameters. 

• Results section – probe coverage summary and BED files. 
3. Review the design files according to the Guide for Reviewing and Approving for your selected product, which 

are available at sequencing.roche.com/support.html. 
 

Step 6. Approve the Design 
The design can be approved for ordering on the Review tab. 

1. If necessary, proceed to the Review tab using one of the following options: 

• Choose the link to the design in the Recent Designs area on the NimbleDesign Homepage. 

• Choose the link to the design in the Messages area on the NimbleDesign Homepage. 
2. Choose the Approve Design button. 

 
 

http://sequencing.roche.com/support.html
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The NimbleDesign Software automatically generates a Configuration Number (see 
the screenshot above) when the design is approved. This number is essential to 
identifying your custom design should you need to contact Roche. 

 
By approving the design, you are now able to order the design by choosing Add to 
Cart (see Chapter 4). 

 
If you decide that you no longer need a design that you generated using the 
NimbleDesign Software, simply remove it by choosing Delete Design. Designs that 
have been submitted for ordering cannot be deleted. 
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Chapter 4. Order a Design 

 

 
From any place in the program, choose the Cart link in the main navigation bar to go to 
Your Shopping Cart. 

 

The NimbleDesign Software supports online ordering of enrichment designs if your country has online ordering 
through the registration website, as well as non-online ordering. 

Ordering Workflow 
1. Add a design to Your Shopping Cart in one of the following ways: 

a. On the Review tab for an approved design, choose the Add to Cart button. 

 
 

b. On the Your Shopping Cart page, choose Add Design. 
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c. On the Designs tab, choose Add to Cart in the Actions field.

 
 

 
The Configuration # (see the screenshots above and below) is essential to 
identifying your custom design should you need to contact Roche. 

 

2. On the Your Shopping Cart screen, select the Pack Size from the dropdown field. 

 
3. Change the Quantity field to the number of packs that you would like to order. 
 

 
Remove items from your cart by choosing the Remove link. 

 

4. Follow the instructions for online ordering or non-online ordering. 

Online Ordering 

a. Choose the Go to Checkout button. 

b. The website automatically opens in another window or tab of your internet browser. For security reasons, 
you must login again using the same User ID and Password as the NimbleDesign Software. 

c. Proceed with the checkout process. 
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Non-Online Ordering 

a. Choose the Transmit button, which replaces the Go to Checkout button in countries that do not support 
online ordering. 

b. A popup dialog box will appear with your contact information. Verify that your information is correct. 
Make modifications as necessary. Choose OK to transmit your design. 

 
 

c. You will be redirected to the Submission History page. A list of designs transmitted for ordering will be 
listed. A confirmation message will appear next to your submission. 
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d. You will receive an email confirmation of your design transmitted for ordering. 
 

 
If you do not receive an email confirmation that your design was submitted for an 
order, contact tech support at sequencing.roche.com/support.html. 

Your design will be transmitted to an account manager. You will be contacted by 
your local Roche Affiliate to finalize ordering information. 

 

Customer Account Number 
You may be asked to provide a Roche customer number for ordering purposes. A Roche customer account number 
represents a collection of address, shipping and billing data for your account that is currently contained in the Roche 
shipping and billing system. The benefits of having a customer account number include: 

• Customer-specific pricing of quantity discounts 

• Tax exemptions 

• Ability to use a purchase order number 
Without a customer account number, you will be restricted to paying only by credit card and will pay list price and 
local sales tax. 

History Homepage 
Submissions are listed with the most recent order at the top. 

 
• Choose the order submission date to access details of the specific order. 

• Choose the Print button to keep a copy for your records, if desired. 

 
 

http://sequencing.roche.com/support.html
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• Reorder by choosing the Add to Cart button. 

 
 

Design Status 
As your enrichment design passes through the phases of the workflow, the current Design Status is displayed on the 
Design tab. 

• Draft 

• Ready for review 

• Approved 

• Submitted 

• Ordered 

Deliverables for Enrichment Design Orders 
For each design, you will receive a vial containing your targeting DNA oligos in solution. 

Component Description 
SeqCap EZ Choice Library 
SeqCap EZ Choice XL Library 
SeqCap EZ Developer Library 

4, 12, 24, 48, 96, 384, 960 reactions 

SeqCap Epi Choice S Enrichment Kit 
SeqCap Epi Choice M Enrichment Kit 
SeqCap Epi Choice L Enrichment Kit 
SeqCap Epi Developer Enrichment Kit 

12, 48, 384 reactions 

SeqCap RNA Choice Enrichment Kit 
SeqCap RNA Choice XL Enrichment Kit 
SeqCap RNA Developer Enrichment Kit 

12, 48, 384 reactions 

HEAT-Seq Choice 96, 384, 1536 reactions 
HEAT-Seq Choice Ultra S 
HEAT-Seq Choice Ultra M 96, 384, 1536 reactions 

HEAT-Seq Choice Ultra L 384, 1536 reactions 
HEAT-Seq Choice Ultra XL 
HEAT-Seq Choice Ultra XXL 1536 reactions 
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Chapter 5. Retrieve Design Files 

SeqCap and HEAT-Seq design files will be delivered through NimbleDesign once the status is changed to “ordered”. 
This applies to all the designs you own, regardless of having been created in NimbleDesign, or by Production 
Informatics. Design files of the SeqCap catalog design and SeqCap shared design are available to download on the 
Roche website. If you are ordering a design that is shared by a collaborator, the design files are accessible in their 
NimbleDesign account. Request the design files from the collaborators. The design files can be accessed in the 
Review tab under the Designs page, and may include: 

• Probe Info (HEAT-Seq and HEAT-Seq Ultra) 

• Capture Targets BED 

• Primary Targets BED (SeqCap) 

• Coverage Summary 

• User Guides 

• Pack Insert 
 

The Probe Info (HEAT-Seq and HEAT-Seq Ultra) Capture Targets BED files are used in analysis workflows. Their 
use and content are described in detail in the corresponding How To Evaluate Tech Notes, available at 
sequencing.roche.com/support.html. 

If the size of the deliverable files allows, there will be a single zip file containing all of the component files that will be 
available. If you see plain text for the zip file, this indicates that the files must be downloaded individually. 

 
 

http://sequencing.roche.com/support.html
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Appendix A. File Formats for Regions of Interest 

The NimbleDesign Software allows a user to type or paste a coordinate list, import a coordinate or gene name file or 
type a gene name. Four file formats for specifying regions of interest are accepted. 

One Column Text File 
A text file with the information in one field: chromosome:start-stop. 

 

Three Column Text File 
A tabbed text file with three fields: chromosome<tab>start<tab>stop. 

 

Four Column Text File 
A tabbed text file with four fields: chromosome<tab>start<tab>stop<tab>name. The fourth field can contain 
comments or a region name that you want to be carried through to the final enrichment design BED files. 

 
 

 
The contents of the fourth field will not affect the design. 
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A plain text file containing one region per line is required. Coordinates are zero based. It begins at start and ends at 
stop-1. For example: 

chr1<tab>0<tab>1000<tab>  

defines a region that begins at the start of chromosome 1, extends to base 999, and has a length of 1000 bp. 

Files containing commas, blank spaces and/or quotation marks, or Word documents, Excel files or similar 
documents are not acceptable. 

Gene Identifier Text File 
A wide variety of Gene Identifier text file formats are supported by NimbleDesign Software. The Gene Identifiers 
should be placed in a text file with one identifier per line. 

• Ensemble Gene ID(s) 

• Ensemble Transcript ID(s) 

• Ensemble exon ID(s) 

• EMBL ID(s) 

• EntrezGene ID(s) 

• *MIM Gene Accession(s) 

• *HGNC symbol 

• WikiGene ID(s) 

• WikiGene Name(s) 

• miRBase ID(s) 

• miRBase Accession(s) 

• VEGA Gene ID(s) (OTTG) 

• UniGene ID(s) 

• VEGA Transcript ID(s) (OTTT) 

• Refseq Predicted ncRNA ID(s) 

• Refseq ncRNA ID(s) 

• Refseq Predicted mRNA ID(s) 

• Refseq mRNA ID(s) 

• UCSC ID(s) 

• CCDS 
* Available for human, not for mouse genome. 
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Appendix B. Region Padding and Consolidation 

 

 
The identification of genomic regions of interest is case sensitive. If you have regions in 
your regions file that do not agree with the acceptable formats, the NimbleDesign 
Software will modify the names. For example: 

CHR1 226250407 226250457 

will be modified to: 

chr1 226250407 226250457 
 

NimbleDesign Software automatically adjusts region boundaries to optimize the design by padding or consolidating 
regions. If any regions have been renamed, padded, or consolidated, a Consolidated Regions text file and 
Consolidation Report will be displayed in the Regions section of the Review tab (see Guide for Reviewing and 
Approving for your selected product.) 

Pad to Minimal Length 
Sequence capture regions should meet minimum size standards for efficient target capture. A 100 bp minimum 
length threshold is used for SeqCap EZ and SeqCap Epi enrichment designs, while a 50 bp minimum length 
threshold is used for SeqCap RNA designs. In SeqCap RNA designs, regions <30 bp are removed from the regions of 
interest. Uploaded regions will automatically be padded to the appropriate size. For example: 

chr1 226250425 226250475 

will be padded for a SeqCap EZ design to: 

chr1 226250400 226250500 

Consolidate Regions 

Consolidate Overlapping Regions 

If you have regions that overlap in your regions file, the system will automatically consolidate those regions into one 
region. For example: 

chr1 226250407 226257717 
chr1 226255689 226259703 

will be consolidated to: 

chr1 226250407 226259703 

Consolidate Region Names 

When regions are consolidated, the NimbleDesign Software will also consolidate unique names from the optional 
fourth column using a semi-colon (;) as a separator. For example: 

chr1 226250407 226257717 H3F3A 
chr1 226255689 226259703 H3F3AP4 

will be consolidated to: 

chr1 226250407 226259703 H3F3A; H3F3AP4 
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Appendix C. Close Match Parameters 

Background 
Close matches are the number of times in which a probe sequence matches the genome, with a minimum match 
length of 30 bp, including either ≤5 insertions or deletions or a gap of ≤5 bp. Probe selection takes place in two 
phases; an initial selection based on preferred close matches, followed by a filling in of the gaps based on maximum 
close matches (Figure 1). 

 
Figure 1: Close Match Probes. 
 

 
The design process used by the Roche design team starts with an initial selection based 
on the value entered for preferred close matches (as illustrated in blue above), with a 
preference for selecting unique probes in the database. After the initial probe selection is 
completed, the level of coverage is reviewed. If there are insufficient probes available for 
a given region at the preferred close match number, the threshold will be incrementally 
increased until adequate coverage is achieved, or until the maximum close match limit is 
reached (in orange). As illustrated above, solid lines represent probes selected for the 
target region; dotted lines indicated a probe is not selected. Even if a probe fits within 
the maximum close match value it will not be selected if adequate coverage is achieved 
through the preferred close matches probes. 

 

Maximum close matches greater than one may allow increased probe coverage in regions with low sequence 
complexity, e.g. low copy repeat regions, that would not be covered using a maximum close match of one (i.e. unique 
probes). Note: higher maximum close matches may lead to non-specific binding. 

The recommended value for number of maximum close matches depends on your experimental design. If you are 
interested in a design that only includes unique probes, use a maximum and preferred close match value of ‘1’. 
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However, if you are interested in maximizing the coverage of your design, use maximum and preferred close match 
values greater than one. Note: the preferred close match value will always be a number less than or equal to the 
maximum close match. 
 

 
Some regions of the genome are highly polymorphic and/or duplicated, for example the 
MHC (multiple different haplotypes over chr6:28,600,000-33,500,000) and the olfactory 
receptor family (95 different clusters throughout the genome including >380 functional 
genes and >400 pseuodogenes). If your custom design fails to reach adequate coverage 
in these or other target regions, you may contact technical support at 
sequencing.roche.com/support.html to determine options to improve coverage.  

 

 

Strand Choice (HEAT-Seq and HEAT-Seq Ultra Designs Only) 
Coverage = Either Top or Bottom: Choose this option if you would like sequence information from only a single 
strand. Optimal probes will be selected as necessary from either the top strand or the bottom strand to provide 
coverage. For any given region, probes may be exclusively top or bottom strand, or may alternate between the two 
strands. This is the default selection and is appropriate for most experiments. 

Coverage = Both Top and Bottom: Choose this option if you would like sequence information from both strands in 
your experiment. Having sequence information from both strands can assist in assessing DNA damage and provide 
higher confidence in SNP calling. Twice as many probes will be selected, and twice as much sequence will be 
necessary to cover the target regions. 

http://sequencing.roche.com/support.html
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Appendix D. Troubleshooting  

This chapter helps you troubleshoot problems that may occur while creating your design or while using the software. 

Processing Errors 
Message Text Resolution 

Regions: “line xxx: chromosome end location is 
out of range”. 

This indicates that for the specific chromosome that you specified in the regions 
of interest file have either a Stop value or End Location was beyond the range of 
that chromosome. For example hg19 Chromosome 1 (one) has a length of 
247,249,719 – If you enter “chr1:100000000-250000000” you will get this message 
indicating that 250 million was beyond the 247 million range. 

 

Missing Gene Name Coordinates 
Cause Description Fix 

Mistyped Identifier Gene identifiers are case-sensitive, and must 
match what is in the database. Spaces are not 
allowed in the identifier, nor are special 
characters unless they are part of the actual 
identifier. 

Check the identifier spelling, and try again. 

Identifier deprecated/updated In some cases, ENSEMBL has a newer identifier 
of the same type than what has previously 
populated the literature (e.g. MLL = KMT2A; 
C12orf5 = TIGAR). 

Check your identifier source (e.g. HGNC) for 
any updates. Try using ENSEMBL’s web portal 
and substitute the identifier with an ENSEMBL 
identifier of the appropriate type. 

Wrong identifier type An identifier was used that does not exist for 
the type requested (e.g. transcript ID versus 
gene ID). 

Check missed identifiers match with input type. 
Choose the appropriate type, and try again. 

Wrong genome/build An identifier does not exist for the genome 
build selected (e.g. requested mm10, but meant 
GRCh38) 

Check the selected genome build is correct, 
and try again. 
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Appendix E. Glossary  

A 

Application: Refers to the SeqCap EZ, SeqCap Epi, SeqCap RNA, or HEAT-Seq Target Enrichment Systems for 
amplification-based enrichment of DNA or RNA targets. 

B 

Browser Extensible Data (BED) file: A file used by the UCSC Genome browser to define genomic regions. Each line 
in the file defines one genomic region. To learn more about its contents, refer to the full documentation of the BED 
format available from UCSC at genome.ucsc.edu/FAQ/FAQformat.htm. 

bp: Base pair. One of the pairs of chemical bases joined by hydrogen bonds that connect the complementary strands 
of a DNA molecule or of an RNA molecule that has two strands; the base pairs are adenine (A) with thymine (T) and 
guanine (G) with cytosine (C) in DNA and adenine (A) with uracil (U) and guanine (G) with cytosine (C) in RNA. 

C 

Close matches: The number of times in which a probe sequence matches the genome with either ≤5 insertions or 
deletions or a gap of ≤5 bp, as determined by the SSAHA algorithm (see www.sanger.ac.uk/resources/software/ssaha/). 

Configuration number: A number automatically generated by the NimbleDesign Software when a design is 
approved. This is a unique identifier for your custom design. Refer to this number when calling customer service 
with questions about your design. 

Contiguous design: A design with one or more large regions (from 50 kb to several megabases in size), which will 
generally be interspersed with repetitive elements. 

E 

Enrichment Design: An enrichment design is a virtual representation of the DNA probe sequences that are placed 
in the SeqCap EZ, SeqCap Epi or SeqCap RNA product for a specific experimental purpose. 

Exon design: A design with many small targets, the majority of which are smaller than 500 bp and generally low in 
repetitive DNA content. 

F 

Format: Indicates the category that an application falls under based on size of target region or type of organism 
selected. 

http://genome.ucsc.edu/FAQ/FAQformat.html
https://www.sanger.ac.uk/resources/software/ssaha/
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H 

HEAT-Seq and HEAT-Seq Ultra Target Enrichment Systems: Applications that provide an amplification-based 
enrichment method that combines a fast and easy workflow with powerful SNV detection for targeted resequencing 
applications in human genetic disease and cancer. Employing an advanced version of Molecular Inversion Probe 
(MIP) technology, the HEAT-Seq Systems are available in catalog and custom formats, delivering reliable 
performance to enable researchers to get the most out of their time and resources. 

• HEAT-Seq Catalog Panels are designed for various applications in cancer research: 
o The HEAT-Seq Oncology Panel targets the coding region of 60 common oncogenes. Ideal for new 

variant discovery and validation, this panel contains 5,144 probes, and has a capture target of 
approximately 235 Kb. 

o The HEAT-Seq Ultra Oncology HotSpot Panel is designed for the detection of variants in commonly 
targeted oncogenic hot spots. Containing 635 probes and with a capture target of about 28 Kb, this 
panel is highly scalable and well suited to high-throughput applications where detection of low-
frequency variants is critical. 

• HEAT-Seq Custom Designs enable enrichment of customized set of regions of interest using a database of 
empirically balanced probes. Custom designs are offered in two configurations for maximum flexibility: 
o HEAT-Seq Choice products offer the creation of custom designs targeting genes associated with 

human genetic disease and cancer. Designs may range in size between 140 and 27,343 probes. 
o HEAT-Seq Ultra Choice custom designs offer a special focus on common cancer genes. Designs are 

created using between 32 and 6,000 probes and offer 5% MAF detection. 
M 

Maximum close matches: The final selection of probes for a given region will only include probes with this number 
of close matches or less (see entry for Close matches). If there are insufficient probes available for a given region at 
the preferred close match number, the threshold will be incrementally increased until adequate coverage is achieved, 
or until this limit is reached. 

P 

Preferred close matches: The initial selection of probes for a given region will only include probes with this number 
of close matches or less (see entry for Close matches), with a preference for selecting unique probes in the database. 

Probe: A fragment of DNA that is used with DNA samples to detect the presence of nucleotide sequences that are 
complementary to the probe. 

R 

Region(s) of interest file: A one-per-line listing of the genomic positions you wish to base your design on. The 
format of this text file can be: 

• tab-delimited with three fields: chromosome<tab>start<tab>stop 

• tab-delimited with four fields: chromosome<tab>start<tab>stop<tab>name 

• the information in one field: chromosome:start-stop 
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S 

SeqCap EZ Target Enrichment System: Applications that use native genomic DNA as the target regions for 
sequence capture fall under the SeqCap EZ Target Enrichment System. SeqCap EZ custom probes designed using 
NimbleDesign Software are categorized into three formats based on the size of target region and type of organism 
selected. 

• SeqCap EZ Choice: Refers to custom probes for targeted capture of up to 7 Mb of native human genomic 
regions created using Roche proprietary sequence capture technology. 

• SeqCap EZ Choice XL: Refers to custom probes for targeted capture of up to 200 Mb of native human 
genomic regions created using Roche proprietary sequence capture technology. 

• SeqCap EZ Developer: Refers to custom probes for targeted capture up to 200 Mb of non-human genomic 
regions and unconventional human designs created using Roche proprietary sequence capture technology. 

SeqCap Epi Enrichment System: Applications that use bisulfite-converted genomic DNA as the target regions for 
sequence capture fall under SeqCap Epi Target Enrichment System. SeqCap Epi custom probes designed using 
NimbleDesign software are categorized into four formats based on the size of target region and type of organism 
selected. 

• SeqCap Epi Choice S: Refers to custom probes for targeted capture of up to 30 Mb of bisulfite-converted 
human genomic regions created using Roche proprietary sequence capture technology. 

• SeqCap Epi Choice M: Refers to custom probes for targeted capture of between 30 Mb and 60 Mb of 
bisulfite-converted human genomic regions created using Roche proprietary sequence capture technology. 

• SeqCap Epi Choice L: Refers to custom probes for targeted capture of between 60 Mb and 90 Mb of 
bisulfite-converted human genomic regions created using Roche proprietary sequence capture technology. 

• SeqCap Epi Developer S: Refers to custom probes for targeted capture of up to 30 Mb of bisulfite-
converted human or non human genomic regions created using Roche proprietary sequence capture 
technology. 

• SeqCap Epi Developer M: Refers to custom probes for targeted capture of between 30 Mb and 60 Mb of 
bisulfite-converted human or non human genomic regions created using Roche proprietary sequence 
capture technology. 

• SeqCap Epi Developer L: Refers to custom probes for targeted capture of between 60 Mb and 90 Mb of 
bisulfite-converted human or non human genomic regions created using Roche proprietary sequence 
capture technology. 

• SeqCap Epi Developer XL: Refers to custom probes for targeted capture of between 90 Mb and 210 Mb of 
bisulfite-converted human or non human genomic regions created using Roche proprietary sequence 
capture technology. 

SeqCap RNA Enrichment System: Applications that use the transcriptome as the target regions for sequence 
capture fall under the SeqCap RNA Target Enrichment System. SeqCap RNA Custom probes designed using 
NimbleDesign Software are categorized into three formats based on the size of target region and type of organism 
selected. 

• SeqCap RNA Choice: Refers to custom probes for targeted capture of up to 7 Mb of native human genomic 
regions created using Rocheproprietary sequence capture technology. 

• SeqCap RNA Choice XL: Refers to custom probes for targeted capture of up to 100 Mb of native human 
genomic regions created using Roche proprietary sequence capture technology. 

• SeqCap RNA Developer: Refers to custom probes for targeted capture of up to 200 Mb of human or non 
human genomic regions created using Roche proprietary sequence capture technology. 
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Sequence Capture: A technology that employs a collection of probes that are complementary to regions of interest 
in a genome, which includes a mechanism that enables selective enrichment for these complementary regions. This 
technology facilitates targeted DNA sequencing of a genomic sample, enabling greater depth of sequencing coverage 
for regions of interest such as exons or specific gene sets. 

SignalMap: Provides a simple browsing interface for Roche applications where data is mapped to genomic tracks. 
For more information and to download software, refer to sequencing.roche.com/products/software/signalmap-
software.html. 

T 

Tm: The calculated melting temperature (the temperature at which the hydrogen bonds between complementary 
nucleotide bases break during denaturation) of a probe sequence. 

U 

UCSC Genome Browser: University of California, Santa Cruz. This website provides extensive tools for viewing 
genomic data. For more information, refer to genome.ucsc.edu/index.html. 

http://sequencing.roche.com/products/software/signalmap-software.html
http://sequencing.roche.com/products/software/signalmap-software.html
http://genome.ucsc.edu/index.html
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1. Limited Warranty 

Terms and conditions of use, including limited warranty, are set forth in the Terms and Conditions for NimbleDesign you agreed to in 
connection with account registration. By using this product you reaffirm your acceptance of such Terms and Conditions. 
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